Topic: Sequential Control Modules

Contents

Describe Common Device Functionality ................................................................................................3
Describe Common Device Functionality

Prerequisites

- Knowledge of Configuration Studio.
- Knowledge of Control Builder
- Knowledge of configuring Control Modules and Sequential Control Modules
- Knowledge Builder available

Introduction

- In this lab, you will configure a Control Module called PumpControl which will work as a common device for two Sequential Control Modules (SCM_Tank1 & SCM_Tank2) so as to understand the concepts of Common Device functionality.
The figure shows one feeding tank whose material is stored in two tanks for different applications. One pump is delivering material from the feeding tank to two tanks. You will configure the Pump as a ‘Common Device’ for the two tanks, Tank1 and Tank2.

In this lab procedure you will build the SCM ‘SCM_Tank1’ and then copy it to another SCM ‘SCM_Tank2’, which will then operate the Common Device Pump to control the levels in two tanks.
Complete the following steps in Control Builder.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Configure a CM</td>
</tr>
</tbody>
</table>

1. Open Control Builder application if not already opened.

2. Make the Project Tree window active, then click **File > Import**.

3. Import (with CEE assignment) the CMs - PumpControl, LCtank1, LCtank2, FC1, FC2, from the following path:
   
   `C:\Documents and Settings\All Users\Application Data\Honeywell\Experion PKS\XPORT\Student\Common Device Functionality`

   **ATTENTION**

   LCtank1 and LCtank2 are level controlling CM's for Tank1 and Tank2 respectively
   
   FC1 and FC2 are valve controlling CM's for valves valve1 and valve2 respectively
   
   PumpControl is a CM used for pump operation
   
   The purpose of the lab simulation is to illustrate Common Device functionality.

4. From the Project window, select and load FC1, FC2, LCtank1, and LCtank2.
   - Click **Continue** in the Load dialog
   - Make the post load state active, click **OK**.

5. Double-click PumpControl from the **Project** tab to open its chart view.
### Sequential Control Modules

**Describe Common Device Functionality**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 6    | **Open PumpControl’s configuration form. To enable common device functionality, enter the following details**  
**On the **Main** Tab:**  
SCM Option   : COMMON  
Mode Attribute Reference : PumpControl.DEVCTLA.MODEATTR  

![Configuration Form](image1.png)  
**On the** Arbitration **Tab:**  
Maximum Granted Requesters : 1  
Maximum Waiting Requesters : 10  

![Arbitration Tab](image2.png)
## Sequential Control Modules
### Describe Common Device Functionality

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| **7** | Save and close **PumpControl**.  
If not already assigned to the CEE, assign PumpControl to the CEE of **ACE_13** and then load the CM.  
From the Load dialog, check the “Automatically Change….” Option in the Load Dialog and click **OK**. |

### Create a SCM to use Common Device functionality

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>8</strong></td>
<td>Click <strong>File &gt; New &gt; Sequential Control Module</strong>.</td>
</tr>
</tbody>
</table>
| **9** | Double-click the SCM to open its Configuration Form.  
On the **Main** tab enter following:  
- **Name**: **SCM_Tank1**  
- **Item Name**: **SCM_Tank1_Item**  
- **Parent Asset**: **C11**  
- **Description**: **Common Device Functionality Test**  
Click **OK**.  
Save and close **SCM_Tank1** |

### Table: SCM Configuration Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>SCM_Tank1</td>
</tr>
<tr>
<td>Item Name</td>
<td>SCM_Tank1_Item</td>
</tr>
<tr>
<td>Parent Asset</td>
<td>C11</td>
</tr>
<tr>
<td>Description</td>
<td>Common Device Functionality Test</td>
</tr>
<tr>
<td>Engr Units</td>
<td>Version 0.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>10</strong></td>
<td>Assign <strong>SCM_Tank1</strong> to the CEE of <strong>ACE_13</strong></td>
</tr>
<tr>
<td><strong>11</strong></td>
<td>Open <strong>SCM_Tank1</strong> from Project.</td>
</tr>
</tbody>
</table>
In the **Invoke Transition**, add a condition and enter the following:

**On Main tab enter:**
- **Name:** Check

**On Cond.#1 tab enter:**
- **Description:** Check Tank level has reached a low level
- **Condition Expression:** LCtank1.PIDA.PV<=20

**On Gates tab enter:**
- **Primary Gate Type:** Connect
- **Secondary Gate Type:** Connect

Click **OK**.
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 13   | **Add a Step** with three outputs, enter the following:  
Double click the STEP block to open its properties window  
**On the Main tab enter:**  
Name : Pump On  
**On the Out#1 tab:**  
Description : Turn On flag to start the pump  
Type : S_IEC  
Expression : PumpControl.FLAGA.PVFL:=1  
**On the Out#2 tab:**  
Description : Change FC Mode attribute to program  
Type : NULL  
Expression : FC1.PIDA.MODEATTR:=2  
**On the Out#3 tab:**  
Description : Open Valve to Tank  
Type : NULL  
Expression : FC1.PIDA.SP:=80  
Click **OK.** |
| 14   | **Add a Transition** to wait for the level to reach a high level.  
Enter following:  
**On Main tab enter:**  
Name : CheckTank  
**On Cond.#1 tab enter**  
Description : Check tank level reached a high level  
Condition Expression : LCtank1.PIDA.PV>=75  
**On Gates tab enter**  
Primary Gate Type : Connect  
Secondary Gate Type : Connect  
Click **OK.** |
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Add a step with four outputs. Enter the following:</td>
</tr>
<tr>
<td></td>
<td><strong>On Main tab enter:</strong></td>
</tr>
<tr>
<td></td>
<td>Name : PumpOFF</td>
</tr>
<tr>
<td></td>
<td>Description : Turn OFF Pump and Valve</td>
</tr>
<tr>
<td></td>
<td><strong>On Out#1 tab enter:</strong></td>
</tr>
<tr>
<td></td>
<td>Description : Turn OFF Flag to stop the pump</td>
</tr>
<tr>
<td></td>
<td>Type : R_IEC</td>
</tr>
<tr>
<td></td>
<td>Expression : PumpControl.FLAGA.PVFL:=0</td>
</tr>
<tr>
<td></td>
<td><strong>On Out#2 tab enter:</strong></td>
</tr>
<tr>
<td></td>
<td>Description : Set FC Mode attribute to Program</td>
</tr>
<tr>
<td></td>
<td>Type : NULL</td>
</tr>
<tr>
<td></td>
<td>Expression : FC1.PIDA.MODEATTR:=2</td>
</tr>
<tr>
<td></td>
<td><strong>On Out#3 tab enter:</strong></td>
</tr>
<tr>
<td></td>
<td>Description : Turn off valve</td>
</tr>
<tr>
<td></td>
<td>Type : NULL</td>
</tr>
<tr>
<td></td>
<td>Expression : FC1.PIDA.SP:=10</td>
</tr>
<tr>
<td></td>
<td><strong>On Out#4 tab enter:</strong></td>
</tr>
<tr>
<td></td>
<td>Description : Set FC Mode attribute to operator to allow operator change</td>
</tr>
<tr>
<td></td>
<td>Type : NULL</td>
</tr>
<tr>
<td></td>
<td>Expression : FC1.PIDA.MODEATTR:=1</td>
</tr>
<tr>
<td></td>
<td>Click OK.</td>
</tr>
<tr>
<td>16</td>
<td>Add a <strong>Transition</strong> to wait for the level to reach a low level, then loop back. Enter following:</td>
</tr>
<tr>
<td></td>
<td><strong>On Main tab enter:</strong></td>
</tr>
<tr>
<td></td>
<td>Name : LoopBack</td>
</tr>
<tr>
<td></td>
<td><strong>On Cond.#1 tab enter</strong></td>
</tr>
<tr>
<td></td>
<td>Description : Check tank level reached a low level</td>
</tr>
<tr>
<td></td>
<td>Condition Expression : LCTank1.PIDA.PV&lt;=20</td>
</tr>
</tbody>
</table>
17. Connect steps and transitions as shown.

18. Save and close SCM SCM_Tank1. Load SCM SCM_Tank1 to the CEE.

19. The SCM for Tank2 is similar, instead it will use FC2 and LCTank2. To build SCM_Tank2, right click and copy SCM_Tank1 and name the SCM SCM_Tank2. Change FC1 to FC2, LCTank1 to LCTank2.
Sequential Control Modules
Describe Common Device Functionality

<table>
<thead>
<tr>
<th></th>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>Assign <strong>SCM_Tank2</strong> to the CEE of <strong>ACE_13</strong></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Load SCM <strong>SCM_Tank2</strong> to the CEE. Leave SCM <strong>SCM_Tank2</strong> Inactive until later in the lab.</td>
<td></td>
</tr>
</tbody>
</table>

Using SCM action qualifiers S_IEC and R_IEC

22 Open **PumpControl** in Monitoring and observe that the Mode Attribute of **DEVCTLA** is **OPERATOR** as originally defined in Project.

Later when your SCM starts, PumpControl’s DEVCTLA Mode Attribute will change to Program because you defined earlier in the lab the following

- the SCM Option as Common, the Mode Attribute Reference as PumpControl.DEVCTLA.MODEATTR and
- enabled Equipment Mode Tracking (MODETRACK) on the SCM.
### Sequential Control Modules

**Describe Common Device Functionality**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 23   | Only 1 SCM is activated to help become familiar with Common Device acquisition. To explore Common Device Functionality, first  
- Activate only SCM **SCM_Tank1**  
- Keep SCM **SCM_Tank2** Inactive for now |
| 24   | Change **SP** value of **FC1** to **10**  
Note that when LCTank1’s PV changes to <20, the PumpControl turns on. |
| 25   | Call up the Properties of CM **PumpControl** in Monitoring.  
Choose the **Arbitration** tab.  
Observe **SCM_Tank1** has acquired CM. |

**SYSTEM:CONTROLMODULE Block, PumpControl - Parameters [Monitoring]**

<table>
<thead>
<tr>
<th>Requests Granted</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Granted Requesters</td>
<td>Resource Is Not Available</td>
</tr>
<tr>
<td>Number of Granted Requesters</td>
<td>Resource Is Used</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name of Requesting Block</th>
<th>Resource Is Unused</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCM_Tank1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 26   | Observe the following sequence over the next several minutes:  
- When PV <20 of LCTank1, the invoke transition condition in SCM_TANK1 is satisfied. The step S_IEC action gets executed and acquires CM PumpControl. PumpControl will remain acquired till R_IEC action gets executed.  
- When PV >75 of LCTank1, the Check1 transition condition in SCM_TANK1 is satisfied. The step R_IEC action gets executed and turns CM PumpControl off.  
- The process then loops so that you can observe acquisition. When you are satisfied that you understand how acquisition occurs, close the Module Properties window for PumpControl and go to the next step in the lab |
How two SCM’s can arbitrate a single CM

27. The next steps will have 2 SCMs use PumpControl as a Common Device.
   - In Monitoring, open the charts for SCM_Tank1, SCM_Tank2, PumpControl.
   - From Control Builder’s menu, select Window>Tile to arrange the windows.
   - With SCM_Tank1 continuing to loop, activate SCM_Tank2.
   - Depending on the current values, in your SCM Tank displays, you will see one of the SCMs waiting to store a command. Its step output will appear as a gray color.
### Sequential Control Modules

**Describe Common Device Functionality**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>28</strong></td>
<td>Call up the Module Properties for PumpControl and select its Arbitration tab. On the tab, you will observe a SCM that has acquired the CM and a SCM which is waiting to acquire PumpControl. (Note: The SCMs will alternate as granted and waiting requesters as they loop through their programs)</td>
</tr>
</tbody>
</table>

**SYSTEM:CONTROLMODULE Block, PumpControl - Parameters [Monitoring]**

<table>
<thead>
<tr>
<th>Requested Granted</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Granted Requesters</td>
<td>Resource Is Not Available</td>
</tr>
<tr>
<td>Number of Granted Requesters</td>
<td>Resource Is Used</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name of Requesting Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCM_Tank1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Requested Pending</th>
<th>Conflicts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Waiting Requesters</td>
<td>Unmanaged Conflicts</td>
</tr>
<tr>
<td>Number of Waiting Requesters</td>
<td>Some Waiting Requests</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name of Requesting Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCM_Tank2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Request Granted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of concurrent owners</td>
</tr>
<tr>
<td>Max. number of concurrent owners</td>
</tr>
<tr>
<td>1. SCM_Tank1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Request Pending</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of waiting requesters</td>
</tr>
<tr>
<td>Max. number of waiting requesters</td>
</tr>
<tr>
<td>1. SCM_Tank2</td>
</tr>
</tbody>
</table>

**29** | The acquisition status of **PumpControl** can also be seen in Station. Call up the detail display of **PumpControl** and select the **Arbitration** tab. Observe that an **SCM_Tank#** has acquired CM while the other **SCM_Tank#** is a waiting requester that is waiting for the CM to be released. (Note: The SCMs will alternate as granted and waiting requesters as they loop through their programs) |
### MODETRACK Processing

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>Form Control Builder, open the chart view of PumpControl in Monitoring view. Note that the MODEATTR of DEVCTLA is PROGRAM because SCM_Tank# is in AUTO and RUNNING mode.</td>
</tr>
</tbody>
</table>

**ATTENTION**

Because the SCM Option (SCMOPT) for the CM PumpControl is Common,

- the MODEATTR of DEVCTLA changes to Program when SCM Mode changes to AUTO
- the MODEATTR of DEVCTLA changes to Operator when SCM Mode changes to MAN

| 31   | To observe the mode attribute behavior, you will only need to use SCM_Tank1.  
- Before you stop SCM_Tank2, check that the Stopped State Option on SCM_Tank2’s Main Tab is set to Terminal and the Release Resources option on the Other Settings tab is enabled. This will release any acquired resources it may have when you stop the SCM. You can change these settings in Monitoring.  
- Stop SCM_Tank2  
- Call up SCM_Tank1 in Chart view in Monitoring mode and open its Module Properties |
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td>From SCM_Tank1’s Status tab, change the SCM Mode attribute to MANUAL. Click Yes and then OK.</td>
</tr>
<tr>
<td>33</td>
<td>Note the Mode change on SCM_Tank1 to Manual.</td>
</tr>
<tr>
<td>34</td>
<td>From Control Builder, open the chart for CM PumpControl.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>35</td>
<td>Check the MODEATTR of DEVCTLA in PumpControl. The MODEATTR should change to OPERATOR because SCM SCM_Tank1 is in MANUAL mode.</td>
</tr>
</tbody>
</table>

**ATTENTION**

Remember that as long as the CM **PumpControl** remains ACQUIRED by **SCM_Tank1**, you will see the mode change take place.

| 36   | From the Status tab of the SCM, change the SCM_Tank1 mode back to AUTO. Check that the DEVCTLA in PumpControl has returned to a PROGRAM mode attribute. |
## Sequential Control Modules

**Describe Common Device Functionality**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>37</td>
<td>Open SCM_Tank1 in monitoring and then open its module properties. From the <strong>Other Settings</strong> tab, note EQM Mode tracking is <strong>ONESHOT</strong></td>
</tr>
</tbody>
</table>

![EQM Mode Tracking](image)

**SYSTEM: SCM Block, SCM_Tank1 - Parameters (Monitoring)**

<table>
<thead>
<tr>
<th>Server Displays</th>
<th>Control Confirmation</th>
<th>Status</th>
<th>QVCS</th>
<th>Identification</th>
<th>Dependencies</th>
<th>Other Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main</td>
<td>Arbitration</td>
<td>Handers</td>
<td>Alarm and Event</td>
<td>Recipe</td>
<td>History</td>
<td>Other Settings</td>
</tr>
</tbody>
</table>

- EQM Mode Tracking: ONESHOT
- Release Resources:
  - In Normal Termination
  - In Abnormal Termination

| 38   | Open CM **PumpControl** in monitoring window. Verify the **MODEATTR** of the **DEVCTLA** block is in **PROGRAM** |

Change **MODEATTR** of **DEVCTLA** to **OPERATOR**

**Result:** If PumpControl is acquired, you will have a runtime error on SCM_Tank1. Return PumpControl’s mode attribute to Program to clear the runtime error on SCM_Tank1.

**ATTENTION**

In this step, the EQM Mode Tracking Option is **ONESHOT** and mode of **DEVCTLA** block is **AUTO**. Since the Mode Tracking option is set as **ONESHOT** the **MODEATTR** of **DEVCTLA** will allow a change to **OPERATOR**.

For more details about the EQM Mode tracking Options and how they change **MODEATTR** of **DEVCTLA**, refer to Knowledge Builder, Experion R310.2 → Configuration → Sequential Control User’s Guide → Planning Sequential and Procedural Control → Common Device Algorithm Overview → MODETRACK Processing

| 39   | Open SCM_Tank1 in monitoring and open its module properties window. Click on **Other Settings** tab |

Change the **EQM Mode tracking** to **CONT**
### Sequential Control Modules
Describe Common Device Functionality

<table>
<thead>
<tr>
<th>✓</th>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>Open CM <strong>PumpControl</strong> in monitoring window. Verify the <strong>MODEATTR</strong> of the <strong>DEVCTL A</strong> block is in <strong>PROGRAM</strong>. Try to change <strong>MODEATTR</strong> of <strong>DEVCTL A</strong> to <strong>OPERATOR</strong>. Result: You will not be able to change <strong>MODEATTR</strong> of <strong>DEVCTL A</strong> to <strong>OPERATOR</strong>, you will see a message indicating mode attribute change is not allowed.</td>
<td></td>
</tr>
</tbody>
</table>

**ATTENTION**

Since EQM Mode Tracking Option is **CONT**, **MODEATTR** of **DEVCTL A** will remain in **PROGRAM**. Notice this will also not change to **OPERATOR** even if the SCM mode is changed to **Manual**.